USC Marshall School of Business Word 2007 Cheat Sheet

Academic Information Services Find Word 2003 Commands in Word 2007

Use this handout to find where Word 2003 commands are located in Word 2007. It consists of the following three
sections:

e Navigation tips about getting around in Word 2007.

e New location of buttons from the old Standard and Formatting toolbars.

e New locations of the old menu items.

NAVIGATION TIPS
Tabbed Ribbons
The old menu system and toolbar buttons have been combined into stationary tabs with buttons on them.
Right click any button to add it to Click a tab to view a Double click a tab to hide all buttons.
the Quick Access toolbar. _.--~"" different set of buttons. .-~ Double click a tab again to view the buttons.
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Quickly Browse Through Tabs Home Insert Page Layout References Mailings

If you hover your mouse within the ribbon area and

11 || A A4S

spin your mouse wheel, you can quickly scroll through d$ Calibri (Body)
the tabs. | =
|

Split Buttons

Note that some buttons
have two halves. The top
part issues its most
common use while the

v

-

bottom part bringsupa .-

8
'pt'ﬂg
aste B 7 U -
S A J

7 @ paste

Calibri (Body)

list of commands. g 4 Paste Special...
&9 Paste as Hyperlink
Accessing More Options
s Some sections on the Paragraph 3
— ; . B ribbon have a “More” Indents and Spacing | Line and Page Breaks
= Bz || O E arrow which will bring up P
Pt | window with more options. :
Paragraph ;e N P aligrinent: v
J Most of these you have
.- Qutling level: | Body Text v
probably seen before.
Indentation
Left: o =] Special: By:
Right: o = (none) - -

Right Click for Quick Commands Sk

If you right click an area or object in Word, you will get a pop-up  .----~
menu and usually a small formatting tool bar. The pop-up menu

commands will change to reflect the area or type of object you right AN
clicked. R

Keyboard Shortcuts
Most shortcut keys still work (for example, Control + S saves).

 Calibri (Boc~ 11+ A™ A7 Ay jF
B 7 E‘V A' "- _L’

s— |
==

ord 2003 commands arelocated i

| 3% Paste 1
4 | Adjust List Indents...

- -

Decrease Indent

v Ay

Increase Indent

. . . - A Font..
However if you used to navigate the menu by pressing the ALT 1 = 5 =
. =y Paragraph...
key, the letters or numbers you have to press now will be a i — Sullet
. :=—| Bullets >
different sequence. =
| i=  Numbering L
. & Hyperlink... ’
) DL OBBTHF)veamon |
& LookUp..
I Pa out Ref ces Mailings hl
H mﬁt i [ B M A ’
N |
=1 & A | e = = 1 Translate 4
~ AR | |22 || = 3
J Ee < i Styles »
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The Quick Access Toolbar

This is the only customizable toolbar in Word. You can add and remove

buttons from it and if desired, move its location to below the ribbon rather

than above.

Adding Buttons to the Quick Access Toolbar

There are several methods of adding buttons to the Quick Access Toolbar:

_— =0 %
Right click any button on any tab and select ------------ > S— . —
“Add to Quick Access Toolbar” - AddinQuidehccessianibag
: Paste
- Customize Quick Access Toolbar...
Click the drop down arrow on i.ts right and B _'."Q:a—"'— -9 - \\E{i/,’
then click the command yF)u szh t.o _J/ — insert, Customize Quick Access Toolbar
appear on the toolbar. Click it again to |
remove the command. = ¥ _ g New.____. N
J __1 Arial | Open :
Paste b B iedi g'! v | Save [\\‘3 E
To view all available buttons G Customize the Quick Access Toolbar.
and organize the QUICk Choose commands from: (| Customize Quick Access Toolbar:
Access TOOI ba r: Popular Commands v For all documents [default) -
. . <Separators ~ I save
a. Right click any button. 9 Undo '
b. CIICk ”customize Quick _-:,,1 Caleulate Sheet O Redo k
” illl Create Chart
Access Toolbar”. " Eustom SortT <~ _
c. Selectanicon fromthe --f T DetashectFormatting =
=™ Delete Cells... N
list then click the ”Add" W' Delete Sheet Columns \~\
=" Delete Sheet Rows
button. g3 Ema A | ___
d. Organize the toolbar by f: Insert Cells... ) ! > <]
. ¥, Insert Hyperlink ! | .- i |
using the Up/down T~ |l - i insent Picture trom File I\__ } UL '~le
arrows. i msetyottale - - o
5 Insert Sheet Columns =~~~ - -----=7
Remove Buttons to the Quick Access Toolbar L'“-a \\ g e =
1. Right click the button to be removed. ' _J/ | Remove from Quick Access Toolbar
2. Select “Remove from Quick Access Toolbar”. N Hoy S =
Move the Quick Access Toolbar Below the Ribbon
This will give you room for more buttons —
without cutting off your file on the title bar. ) d 9 - v movie
) s Remove from Quick Access Toolbar IE
1. Right click any button on the Quick Access - Customize Quick Access Toolbar... f
Toolbar. ® A Sh ick Access Toolbar Below the Ribb
2. Select “Show Quick Access Toolbar Below =} 43 Shompuidehccesstooibakbciomiholinban l}g*
i ” Paste B Minimize the Ribbon
the Ribbon”. ¥ n
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NEW LOCATION OF BUTTONS FROM THE OLD
STANDARD AND FORMATTING TOOLBARS

Standard & Formatting Toolbar Buttons — | Word 2007 Location

Word 2003
=== == = E|
Alignment — Home -
B (B U ~ abe 3%, % Aa~|
Bold Home -
= i
Borders Home - L—
- B
Bullets and Numbering Home - =
== EE Columns -
Columns Loz Page Layout -
)
_.é
Cut, Copy, Paste & - Pafte 7
Home - | Clipboard i
,_'ﬁ ) Document Map
Document Map View -

The tools on this toolbar have been dispersed into several locations.

N

Shapes

| 4B Drawing tools: Insert -
Drawing If you click an object you have drawn, a “Format” tab will appear which has
most of the formatting options

! Format
for drawn objects.
Times Mew Roman - Calibri (Body] 111 -
Font Home -
é b é -
Font Color Home -
_ 12 - Calibri (Body) 11 -
Font Size Home -
Format Painter J Home - J
abr 382 ~
Highlight Home -
iE i || €€ £E
Indent Home - :
Insert Excel Worksheet Table &y Excel Spreadsheet
Insert - = -
_. '! Hyperlink
Insert Hyperlink E" Insert - L=
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Standard & Formatting Toolbar Buttons — | Word 2007 Location

Word 2003
Insert Table Table
Insert - o
-4 |B I U ~abe x, X Aa~|
Italic Home -
=, =T
Line Spacing L= Home - L2
—
I.J |"E!i"l \j
T | Mew
New ~ then
o
f =y
Open ) : EE ./ Qpen
= then
'{-.-'_\- - - -
(Oa :;ﬁ - . Restrict Permission
Permission (Info Rights Mgmt.) B il then Epare then |_= G:_alr_]:c EEDEIE access
.-/.d_\-
Print = !I EE L@ﬂ Print k
. then
= y Print Preview
Print Preview 2 !' EE L@ﬂ Print » g Preview and m
2 then then printing.
._u ﬂead M
Read Full Screen
View - Reading
P I."EE: H q - {ﬂ -
Redo ) i
On Quick Access Toolbar: L= Home Insert
Research £ i
Review - Research
o
El ()
Save s |
On Quick Access Toolbar: L= Heg
Al (alz
2LAL 2 £ |24
Sort Sort & Z| sort
Home - L7 Also under DATA
e £
Spelling . Spelling
Review -

© Marshall School of Business - USC 7/12/07 By Wayne Wilmeth Page 5 of 13



Tables and Borders

Standard & Formatting Toolbar Buttons — | Word 2007 Location
Word 2003
AaBbCcDe | AaBbCcDe AaBbCi AaBbCc %
Style Harmal T TMormal | Mo Spaci.. Headingl  Heading2 — Change
Styles -
7]
Home - Styles
o AaBbCcDc | AaBbCcDe AaBbCi AaBbCc %
; == TN | | TMoSpaci.. Headingl Heading2 - Change
Styles and Formatting arma a spad 2ading 2ading T Styles~
]
Home - styles
This used to bring up the Tables and Borders toolbar. In 2007, if you click

within a table, you will get two new tabs (Design & Layout) which have the

Table Tools
i Design Layout
same options:
Note that “Draw Table” is under: Insert - Table — Draw Table
u |B F U ~ abe %, % Aa~|
Underline Home -
) 9o
Undo ) ! y
On Quick Access Toolbar: Home Insert
Views Lower right corner of screen J SlElS sl or View tab.
(Y ! (¥
Zoom Lower right corner of screen

© Marshall School of Business - USC

7/12/07

By Wayne Wilmeth

Page 6 of 13



NEW LOCATIONS OF THE OLD MENU COMMANDS

MENU ITEM IN WORD 2003

LOCATION IN WORD 2007

Arrange View — = Arrange All

Arrange All (Windows) View - = Arrange All

Auto Text Insert - | Quick Parts ~

AutoCorrect Options E:E./) 21 Word Options Proofing AutoCorrect Options...
AutoFormat '§ D}y ! [@ Wora options | [eroong | P o —

AutoSummarize

Could not fine; however, you can add it to the Quick Access toolbar by
right clicking the QAT and then selecting “Customize QAT”.

Background Page Layout - <] Page Color ~
Bookmark (insert) Insert - A Bookmark
| o - 4 -
Home - = < Click the drop down for more choices.

Borders and Shading

For page borders only: Page Layout -

1] Page Borders

Break

=l
v=, Breaks ~

Page Layout —
Bullets and Numbering Home - =l T
Change Case Home - a7/
aal
Clear Home - |2 |
Clipboard Home — Clipboard ™=
O ﬁ
Close _j/J J Close
Columns EE Columns ~
Page Layout -

Comment (new)

L d

Mew
Review — Comment
] ] Delete ~
_ #] Previous
Comments (Next/Previous) New
Comment =d Mext
Review — Comments
Compare and Merge Documents Compare Show Source
o Documents
Review - e
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MENU ITEM IN WORD 2003

LOCATION IN WORD 2007

Compare Side by Side

View - =
Copy ==
Home -
. I'rﬂﬁﬂx
Customize ! y 2] Word Options Customize
i o Date & Time
Date and Time Insert - E%)
Diagram ﬁ
Smartart . o w ”
Insert - - (Diagrams have been replaced with “SmartArt”)
Document Map . Document Map
View -
AS -
Drop Cap Insert - — Prop Cap
| Z| Quick Parts —| 2% Sign
Field [ Document Property
. . =] | Field...
Insert — Quick Parts — Field... -
File (insert) ?
File Search ?
34 Find -
Find .
uac REplace
Home -
Calibri (Body) Tl - AT AT ||
Font (format) |m 7 u + abe X, w® MTHEP"?' é,l
Home - il &
Uiy Insert Endnote
ﬁi Mext Footnote -
Footnotes Insert
antnnte A EI-I':".'. ”':lt'-:'.-'
References — I )
Frames ?
Full Screen Full Screen
. Readin
View - ?
33 Find7|
Go To 3 Find...
. = | GoTo..
Home — Fine -
EI -
=
Header / Footer
Header
& Foot .
Insert — Oorer (View — Normal to get out).
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MENU ITEM IN WORD 2003

LOCATION IN WORD 2007

Header and Footer

=

|1||II|.

Header Footer

- -

Insert -
You can also double click the header/footer areas to edit them.
=-' Hide
Hide
. Unhid
View — [ Unhide
Hyperlink (insert) @;J
Insert - Hyperlink
g, Research [~
Language @Thesaurus @
d% Translate e
Review - g 124

Letters and Mailings

- Maili
See the “Mailings” tab -

& Hyperlink

. A= Bookmark
Links
['f] Cross-reference
Links
Insert -
::'.
E=.
Macro Macros
. | Macros |
View — e
=
Mail Merge ) _
Start ail
Mailings - | Merae~
Review
Markup Click the “Review” tab to see markup options.
New § E@ | Hew
New Window View — £33 New Window
Normal \—‘
View — Marmal
Object *§d| Object ~
Insert -
. G~ Create Document Workspace
Online Collaboration (Oa . _ Create a new site for the docum
it | 4 Publish  * keep the local copy synchronize
I'KEHNI m
Open ! y 7 Open
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MENU ITEM IN WORD 2003

LOCATION IN WORD 2007

o

\
asl

&

i
!

2] Word Options

Options Then look under the different links on the left.
=
Outline —
. Outline
View -
Page Break = Page Break
Insert -
Page Break Preview View — =d Page Break Preview
Page Numbers
Page Numbers
Page
Insert - [Imber™
3 Insert Page Layout Referances Mai
24 Orientation = ¥= Breaks - A
= . i .
_j Size ~ £ Line Numbers ~ | <)
Page Setup Margins __ ’
- == Columns - bE~ Hyphenation = Q
Page Setup s || Pags
Page Layout -

Click the “more” button to see more options.

Paragraph (format)

= = = ==
=~ =~ == t-—||%l|| qT|

Home - Paragraph [
Paste _=]
Paste
Home-L = (upper half of button)

Paste as Hyperlink

3 '* Calibri [Body)
= ==

|F‘aste|= (B F U -
- ey =

[ Paste

Paste 5pecial...
|5} Paste as Hyperlink

Home - Lower half of Paste button -

Paste Special

= |4

1= |
E

Paste

-

Home -

(Lower half of button) — Paste Special

Permission

CIirJh-:u&:l

Cia ) %A Prepare I Restrict Permission
_Ef) = &P |_@ Grant people access

- - mbilitag koo modid e e
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MENU ITEM IN WORD 2003

LOCATION IN WORD 2007

Picture
Insert - Picture
- Print
Print b F'@ @ Print > @ Select
: ) ) ather

Print Layout

View -

Print Preview

r’f@
i

Print Preview
Preview and n

@ Erint ’ printing.
— “In  Properties
=
Properties | E% 5% Prepare  # =] view and ed
- as Title, Auth

Protect Document Protect
Document =
. Protect
Review -
Reading Layout _L
g Lay Full 5creen
View - Reading
Reference . References
See the options under the “References” tab.
= =
Repeat Quick Access Toolbar LB | H9-0
34 Find ~
Replace 3 Replace
Home -
4 i
Research
. Research
Review -
Reveal Formatting Shift + F1
¥ Ruler
Ruler View -
—
(Ca
Save T 5 - — -
9 2E I Eﬂ\ H 9 \
- or LTy
—
Save As -r E@

Save as Web Page

rﬁﬂ
Wi

Save As

il
lﬂ Save As
)

- then change the type to “Web Page”.
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MENU ITEM IN WORD 2003

LOCATION IN WORD 2007

Heading2 - Change
St!llllesv pﬁ Select =

S| Select All
Select All
g | Select Objects
Home — Select Select Text with Similar Formatting
Send To ' EE _ﬁ Send
— &~ Create Document Workspace
Shared Workspace [ Eg: 557 Publish » = Create a new site for the workbook and
o =) =4 = keep the local copy synchronized.,
A
Sort Home - 24 |
Speech ?
Spelling %
. Spellin
Review - =P _
Spelling and Grammar :
Spelling &
Review - Grammar
Split View — | = 5P
it — i N split
Split — Remove Split View - -] sp
Status Bar Right click the Status Bar to access Status Bar content options.
iew Side by Side % -
ynchronous Scrolling ==7
. - Switch Macros
Switch Windows eset Window Position | hwindows = -

v | 1 FileZilla.doc [Compatibility Mode]
2 Word_2007_CheatSheets.doox

View — Switch Windows -

Symbol

L) symbaol ~

Insert -

Synchronous Scrolling

il

View — Synchronous Scrolling

Tables (Inserting)

Tables (Manipulating)

Table
Insert - .
Once you have inserted a table, if you click within it, you wil get the two
Table Tools
Design Layout
tabs shown here:

Tabs

Paragraph T Tabs...

Home — -

Task Pane

Discontinued
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MENU ITEM IN WORD 2003

LOCATION IN WORD 2007

|;# i \
Templates and Add Ins R ] Word Options Add-Ins
- then then
A
Text Box
Text
Insert - Box~

Text Direction (In Text Boxes)

A3 Text Direction

Click the text box to make the “Format” tab appear then

nv
3

Theme Thevmes T

Page Layout - = |NEMES
Thumbnails Thumbnails

View -

Replaced by the tabbed ribbon. The only toolbar you can customize is the
Toolbars .

Quick Access toolbar.

|__} Track Changes =
Track Changes =% Highlight Changes...
: ]

Review — Track Changes -

Undo Quick Access Toolbar [/Ela H9-0
— Hide

Unhide

View — ] Unhide
Version Versioning is not available in Office 2007.

Web Component ?
Web Layout
Web
View - Layout
Web Page Preview
Web
View - Layout
ABC
Review -
Word Count Note you can also right click the button in the lower left and select what
L. . Page: 15 of 15 | Words: 1,405
statistics to view.
({ ] J Cne Page
----- 00 @Twn Pages
foom  100% i
Zoom =] Page Width
Zoom

View then

or lower right corner of screen:
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